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The National Anthem of Sri Lanka

 Sri Lanka Matha
 Apa Sri Lanka Namo Namo Namo Namo Matha
 Sundara siri barinee, surendi athi sobamana Lanka
 Dhanya dhanaya neka mal palaturu piri jaya bhoomiya ramya 
 Apa hata sepa siri setha sadana jeewanaye matha
 Piliganu mena apa bhakthi pooja Namo Namo Matha
 Apa Sri Lanka Namo Namo Namo Namo Matha
 Oba we apa vidya
 Obamaya apa sathya
 Oba we apa shakthi
  Apa hada thula bhakthi
 Oba apa aloke 
  Apage anuprane
 Oba apa jeevana we 
 Apa mukthiya oba we
 Nava jeevana demine, nithina apa pubudukaran matha
 Gnana veerya vadawamina regena yanu mana jaya bhoomi kara
 Eka mavakage daru kela bevina
 Yamu yamu vee nopama
 Prema vada sema bheda durerada
 Namo, Namo Matha
 Apa Sri Lanka Namo Namo Namo Namo Matha
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Foreword  

 

The educational objectives of the contemporary world are becoming more complex along 

with the economic, social, cultural and technological development. The learning and teaching 

process too is changing in relation to human experiences, technological differences, research 

and new indices. Therefore, it is required to produce the textbook by including subject related 

information according to the objectives in the syllabus in order to maintain the teaching 

process by organizing learning experiences that suit to the learner needs. The textbook is not 

merely a learning tool for the learner. It is a blessing that contributes to obtain a higher 

education along with a development of conduct and attitudes, to develop values and to obtain 

learning experiences. 

The government in its realization of the concept of free education has offered you all the 

textbooks from grades 1-11. I would like to remind you that you should make the maximum 

use of these textbooks and protect them well. I sincerely hope that this textbook would assist 

you to obtain the expertise to become a virtuous citizen with a complete personality who 

would be a valuable asset to the country. 

I would like to bestow my sincere thanks on the members of the editorial and writer boards as 

well as on the staff of the Educational Publications Department who have strived to offer this 

textbook to you.  

 

 

 

W. M. Jayantha Wickramanayaka, 

Commissioner General of Educational Publications, 

Educational Publications Department, 

Isurupaya, 

Battaramulla. 

2019.04.10     
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Activity 1.1

Select the most suitable expression from the list of expressions given, to fill 
the blanks.

5

6

Laptop computer
Mobile smart phone
Tablet computer

4

2

3

Server computer
Desktop computer
All-in-one computer

1

 List of expressions

a). The ................................ can be used in a single location such as home or 
office. 

b). The ................................ is dedicated to provide respective services in a 
network.

c). The ................................ has a comparatively large screen and can be 
taken from place to place

d). Mobile computers, the student can use for ................................ and surfing 
Internet reading, storing information, refer electronic dictionaries are  
(i) ............................... and (ii) ................................

e). The ................................ cannot be taken from place to place, use least 
space and have several peripheral devices connected to the monitor. 

Preparation of Computer 
Specifications1
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Activity 1.2 

Name the peripheral devices in the image below. Use the number for the 
expressions given in the list. 

5

6

Head phone
Scanner
Speaker

4

8

Mouse
Web camera

7

2

3

Monitor
Printer
Keyboard

1

Activity 1.3

Right click on the "This PC" icon and select "Properties" to check 
the specifications of the processor.

Main memory 
4 GB

Manufacturer - (Intel)
CPU type - (Core i5)
CPU speed  - (2.2 GHz)
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Examine the processor of a few computers and complete the table given 
below.

Name of manufacturer Type of processor Speed (in units)

Activity 1.4

Calculate the capacity of the hard disk. To check the hard disk capacity, 
double click on the icon ‘This PC’. Hard disk is shown as "Local Disk" under 
"Devices and Drives". Sometimes local disk is divided into two as local disk 
C: and local disk D:. The capacity for both are taken together to calculate the 
hard disk capacity.

Compare the hard disk capacity of several computers. 

Activity 1.5

Examine the capacity of the Random Access Memory (RAM) in a few 
computers and compare them.
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 Activity 1.6

Study the specifications given in the following table. Answer the questions that 
follow.

Central Processing Unit Intel® Core™ i7 3.70 GHz
Random Access Memory 4 GB
Hard disk capacity 2 TB
Computer screen 18.5"
Computer system Windows 10
Guarantee period 3 years
Price Rs 75000.00

1. State 3 technical specifications of the computer.
2. Give 2 non-technical specifications when buying a computer.
3. Give the speed of the processor.
4. State the type of the processor.
5. Find the capacity of the main memory.
6. Give the capacity of the hard disk.
7. State the size of the screen.
8. Compare the technical specifications given above with those of some 

other computer in your school or in another place.

Activity 1.7

By considering the important points in buying a computer, fill in the blanks in 
the statements given below by selecting the relevant term from the given list.
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1. The speed of the processor is given in ................................
2. It is better to select a monitor ................................ in size and consumes 

................................ electricity.
3. The capacity of a main memory is given in ................................

With an extended period of warranty, the cost of a computer  
................................

4. The capacity of a hard disk is measured in ................................
5. The capacity of main memory is ................................ than the capacity 

of a hard disk. 

List of expressions

(less, GB, large, GHz, Terra Byte (TB), less, goes up)

Activity 1.8

Given below are technical specifications about two computers A and B. 
Compare them and answer the questions that follow.

Specifications  Computer A Computer B
Processor Intel® Core™ i3 2.40 GHz AMD ® Core 2.0 GHz

Main memory capacity 4 GB 2 GB
Hard disk capacity 1 TB 500 GB
Size and type of monitor 19.5" LED 17 " CRT
Operating system Windows 10 Ubuntu
Period of warranty 1 Year 3 Years
Price Rs. 65000.00 Rs. 58000.00
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1. Who is the manufacturer of the processor in the computer B?
2. Which computer has a main memory with a higher capacity?
3. Which computer has the larger screen?
4. Which computer has a hard disk with a lesser storage capacity?
5. Give three possible reasons for computer A to cost more.
6. State two non-technical specifications. 

Activity 1.9

Classify the peripherals that can be connected to the USB port as input, 
output and storage.
 

Input devices Output devices Storage devices

Activity 1.10

Refer Figure 1.19 in textbook to find answers to the following questions.

a. List out technical specifications other than those mentioned.
b. List out other non-technical specifications than the ones mentioned.
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Activity 1.11

1. In order to prepare specifications for a computer you wish to purchase, 
complete the given table on the next page using the relevant data from the 
following table.

Device Type Speed Price
Processor 2.4 GHz 4000.00

3.2 GHz 6000.00

1.8 GHz 8000.00

2.4 GHz 10000.00

1.6 GHz 12000.00

2.2 GHz 14000.00

Hard disk HDD
500 GB 3000.00

1 TB 5000.00

SSD
120 GB 4000.00

240 GB 6000.00

Monitor 17'' 15000.00

19'' 17000.00

21'' 20000.00
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Memory 512 MB 2000.00
1 GB 3000.00
4 GB 6000.00

Video 
Graphic 
Adapter 
(VGA)

Onboard VGA No extra cost

DIV No extra cost

HDMI No extra cost

Separate VGA 1000.00
DIV with 

VGA 1500.00

HDMI with 
VGA and DVI 2000.00

Sound card Onboard No extra cost

Separate

800.00

Item Specifications Price
Processor
Capacity of main memory 
Hard disk capacity
Size of monitor
Video Graphic Adapter 
Sound card
Warranty
Total
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2. Fill in the table below with the lowest values.

Peripheral unit Specifications Price
Processor
Main memory capacity
Hard disk capacity
Size of monitor
Video Graphic Adapter Separate
Sound card Separate
Warranty 1 year

Total

3. Compare the given technical specifications for 2 computers A and B with 
the requirements. Select the better computer for purchase.

Item Required 
specification 

Computer - A Computer - B 

Processor Quad Core 1.6 
GHz

Dual Core 2.8 
GHz

Quad Core 1.8 
GHz

Main memory capacity 4 GB 2 GB 4 GB
Hard disk capacity 2 TB 1 TB 2 TB
Size of monitor 19” 21” 19”
Audio/video adapter separate onboard separate
Sound card separate separate onboard
Computer system Windows 8 DOS Windows 10
Guarantee 3 Years 2 Years 3 Years

4. With the assistance from your teacher, find the market price of the 
components for the computer you have selected above. Hence calculate 
the total price of the computer.   
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 Open the spreadsheet software installed in your computer. Get to know a 
few tools on the Graphical User Interface.

Menu bar

Text Formatting 
Tools

Alignment and Positioning 
Tools

Sheets

Electronic Spreadsheets2
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Activity 2.1

Let us work on spreadsheet

When a spreadsheet software is opened, a worksheet appears.

1. To open a new worksheet, click on 'New sheet'       

2. To give a diff erent name for the worksheet:

² Take mouse to  and right click on it.

² Select re-name. Type name and press 'Enter'. 

3. To remove worksheet:
² Right click mouse on name of worksheet. Select 'Delete'.

Activity 2.2

Enter data into worksheet

A children’s society decided to collect funds to purchase sports items for its 
students. They issued cards to fi ll boxes for the purpose. 

The details about the money collected during the weekend, money collected 
by each student, the balance after deducting Rs. 50 /= at the printing cost are 
entered to a worksheet. The worksheet is shown in the following page.
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Let us create the spreadsheet shown above:

Step 1 -  On Sheet 1, type the titles as No, Name, Saturday and Sunday 
and other relevant information.

Step 2 -  Change the name of the worksheet as “Weekend Collection”.

Step 3 - Save worksheet in your computer.

Let us save the fi le

² Select File → Save.
² From ‘Save in’, select a suitable location.  
² Type a suitable fi le name as ''Collection''.
² Click "Save" button.

At the end of each action, save the document.

1        No                   Name                Saturday        Sunday            Total          Prin  ng       Balance 
 2 1 Sugath Rs  250.00 Rs  340.00 Rs  590.00 Rs  50.00 Rs  540.00
 3 2 Neela Rs  450.00 Rs  423.00 Rs  873.00 Rs  50.00 Rs  823.00
 4 3 Prabath Rs  300.00 Rs  567.00 Rs  867.00 Rs  50.00 Rs  817.00
 5 4 Mahesh Rs  200.00  Rs  345.00 Rs  545.00 Rs  50.00 Rs  495.00
 6 5 Shereen Rs  290.00 Rs  234.00 Rs  524.00 Rs  50.00 Rs  474.00
 7 6 Kaveesha Rs  500.00 Rs  100.00 Rs  600.00 Rs  50.00 Rs  550.00
 8 7 Lankesh Rs  650.00 Rs    77.00 Rs  727.00 Rs  50.00 Rs  677.00
 9 8 Jagath Rs  350.00 Rs    45.00 Rs  395.00 Rs  50.00 Rs  345.00
 10 9 Suresh Rs  200.00 Rs  123.00 Rs  323.00 Rs  50.00 Rs  273.00
 11 10 Sagarika Rs  150.00 Rs  432.00 Rs  582.00 Rs  50.00 Rs  532.00
 12 11 Menaka Rs  130.00 Rs  234.00 Rs  364.00 Rs  50.00 Rs  314.00
 13 12 Gayan Rs  455.00 Rs  265.00 Rs  720.00 Rs  50.00 Rs  670.00
 14 13 Pabath Rs  230.00 Rs  324.00 Rs  554.00 Rs  50.00 Rs  504.00
 15 14 Hemash Rs  160.00 Rs  245.00 Rs  405.00 Rs  50.00 Rs  355.00
 16 15 Kanthi                             Rs 150.00     Rs 320.00       Rs  470.00 Rs  50.00 Rs  420.00

A B C D E F G



13For free distribution

Activity 2.3

Find total collection during the weekend from each child

² In spreadsheets, formulas are used in calculations.
² ''='' Symbol is used before any formula.
² In a formula, cell name (instead of cell contents) is used.
² Symbols such as +, -, *, / on keyboard are used in calculations 

between cells.
² The result is displayed by clicking the 'Enter' key after each 

formula.

Step 1 - In cell E1, type “Total”

Step 2 - Click E2 cell, which is in front of the name of the fi rst student.

Step 3 -  Type the formula below in the cell and click 'Enter'.

=C2+D2

The formula used to obtain the fi rst result can be copied accordingly in order 
to obtain the total for other students: 

Method 1

Step 1  -  Click the cell with the total already obtained.

Step 2 -  Move the mouse pointer to the right hand side corner at the 
bottom of the square. A small cross known as 'Fill handle' will 
be displayed now.
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Fill handle

Step 3 -  Click the mouse on the ‘File Handle’. Keeping the mouse 
clicked drag to E 16; the last student and release. 

Step 4 -  Then the total of each student will be obtained separately.

Method 2

Step 1 -  Click on cell with fi rst total. 

Step 2 -  Click 'Home' → 'Copy' in the menu.

Step 3 -  Keeping mouse clicked, select cell range for totals.

Step 4 -  Click 'Home' → 'Paste' on menu.

Step 5 -  The total for each student appears.

Step 6 -  Once complete, save the document.

Activity 2.4

Find balance after deducting Rs 50/= from each 
student

   
Step 1 - In cell F1, type “Printing”. In cell G1, type 

“Balance”. In column F, the cell after “Printing”  
type 50. Use “Fill Handle” and cover the rest of 
the list.  



15For free distribution

Step 2 -  Click mouse on cell G2. Type the formula given below and 
press Enter. 

=E2-F2 

Step 3 -  To fi nd the balance for other students, use “Fill Handle” or
'Copy → Paste'  

   Save the fi le after each activity.

Activity 2.5

Let us format the worksheet 

Some formatting have been done to the above document. They are as follows;

1.   There is a border around the cells. 
² Select cell range to add border by clicking the mouse (A1:A16). 

² In menu, under 'Home' ribbon, click on Boarders  and select 
all borders. 

2. The cells are coloured to make them clearer. 
² Use the mouse to select the cell range to add colours.

² In Menu, under 'Home', Click on 'Fill color'  to select suitable 
colours.

3. Boldface headings. 

² Select the headings. In Menu, under 'Home', Click on .
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4. Date and Information in the cells are aligned.
² To align, select cell range for alignment using the mouse. 

² In Menu, under 'Home', Click on the tools for   alignment.  
  

5. Use the number format to show the data as currency unit. 
² Select the cell range for number formatting using the mouse.  

² In Menu, under 'Home', click on the tool  
and select 'Currency'.

² At the end of each action, save the document. 

Note - If the currency unit is not in 'Rupees, follow the steps given 
below;
Control panel → 'Region' → 'Formats' → 'Additional settings' → 

'Currency'. Change the Currency symbol in the currency ribbon to Rs. and 
select 'Apply' and then 'Ok'

Create a new worksheet

Obtain a new worksheet and create the following document. Use formula for 
calculations. Do the necessary formatting.

² File → New → Blank Workbook → Create  

 3 1 Pencils 80 23 57 100 157 10 15.7 7 109.9
 4 2 Pens 45 43 2 150 152 10 15.2 7 106.4
 5 3 Erases 45 23 22 300 322 10 32.2 7 225.4
 6 4 Books 34 43 -9 200 191 10 19.1 7 133.7
 7 5 Bags 67 23 44 50 94 10 9.4 7 65.8
 8 6 Colours 87 54 33 300 333 10 33.3 7 233.1
 9 7 Bo  les 67 23 44 250 294 10 29.4 7 205.8
 10 8 Boxes 54 64 -10 200 190 10 19 7 133
 11 9 Toff ees 78 43 35 300 335 10 33.5 7 234.5
 12 10 Baloon 90 56 34 400 434 10 43.4 7 303.8
 13

 2 Item No Item Stock Sold Balance Replacement 1 Total Packeted No of Packs Packets per  week Grand total

      A               B               C               D                E                   F                   G               H                  I                          J                        K
1
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Formula for calculations
 Ã Balance = Stock - Sold

         =C3-D3
 Ã Total = Balance+Replacement1

         =E3+F3
 Ã No. of packets = Total/Packeted

         =G3/H3
 Ã Grand Total = Number of Packets * Packets per week

         =I3*J3
Tools for formatting ;
1. Boldface
2. Alignment
3. Adding colours to cell range 
4. Using borders 
5. Inserting a row above the worksheet. Data and information are center 

aligned. 

Inserting row/column and merge and center

1. Click the right mouse button on column/row.  Click 'Insert' →  'Enter row'.
2. In the new raw obtained on the top, type the text you want and click 

'Merge and Center'.  

This tool enables merge two or more cells and center align the entered data.
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Activity 2.6

Let us create a mark sheet

Tools for formatting; 
1. Boldface letters and numbers 
2. Alignment
3. Add colours to cell ranges
4. Adding boarders
5. Inserting a row on the top of the worksheet, centre aligning and merging 

data in a cell range
6. Orientation - changing direction of letters

Orientation - changing direction of letters

Step 1 -  Before orientation, space between columns and rows need 
increasing. 

To increase the space drag mouse as shown, among column and rows. If it is a 
column, drag the clicked mouse to right. If it is a row, drag the clicked mouse 
down.

 2

 3 1 Kasun 56 45 24 78 89 292 58.4
 4 2 Seetha ab 45 ab 98  87 230 76.667
 5 3 Kanthi ab ab 78 59  87 224 74.667

6 4 Gayani 89 76 76 76  76 393 78.6
7 5 Deepal 78 77 67 96  ab 318 79.5
8 6 Naseem 67 ab ab 56  69 192 64
9 7 Thanuka 56 45 24 78  89 292 58.4

10 8 Bimalka ab 67 23 56  ab 146 48.667
 11 9 Thiwanga 54 65 78 65  ab 262 65.5

12 10 Pradeepa 56 45 24 78  ab 203 50.75
13

   14  Maximum Marks 89 77 78 98  89
15  Minimum Marks 54 45 23 56  69
16  No of Present Students 7 8 8 10  6

  17  No of Students in class 10 10 10 10  10
  18  

1

A      B                         C                D                E                F                G                H                I                 J
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Step 2 - Select cells to be changed orientation. Click on arrow for 
orientation icon.   Select required direction.

Step 3 -  Change the name of the worksheet to “Mark Sheet”.    
  (Sheet 1 → Mark Sheet)
Step 4 -  Save the created workbook as ''First term marks - 1'' and close
  the workbook.

Activity 2.7

Using functions    

To calculate the values in a range of cells, functions are used. After the ''='' 
symbol, to begin a formula, the function is included. Then the cell range is 
included within brackets. To indicate that it is a cell range, the names of the 
fi rst cell and the last cell are written within and the symbol '':''.

Let us identify a few such functions;

To calculate the total sum in a cell range
= sum(fi rst cell:last cell).

To fi nd the average in a cell range,  
= average(fi rst cell:last cell).

To count the cells with numbers only 
= count(fi rst cell:last cell).

To count cells with data in a cell range, use 
= counta(fi rst cell:last cell).

1

1
2
3

4

A

A

B C
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Let us use the relevant functions in the worksheet created above. 

Open “Mark Sheet 1” that you created and saved earlier.

² File → Open → First term marks - 1 → Open      

Use the following functions, complete the Mark sheet 1.

=sum(C3:G3)
=average(C3:G3)
=max(C3:C12)
=min(C3:C12)
=count(C3:C12)
=counta(C3:C12)

Saving presaved fi le in a diff erent name

² Select 'File' → 'Save as'
² Select a saving location from 'Save in'.
² In front of fi le name, type  a suitable name ''First term mark - 2'' 
² Click 'Save' button.
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Activity 2.8

Sorting 

Sorting data according to total marks obtained 

Sorting data in the alphabetical order (A…..Z) / (Z ….A) 
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Data can be sorted according to our requirements. First, the cell range needs 
selecting. Select all cells in range leaving out only the cells with the titles.

Next, click 'Sort Filter'  in the 'Home' menu.

Select 'sort A to Z' or 'sort Z to A'.

Activity 2.9

Step 1 - Open the document “Collection” created in Activity 2.2.
Using the information in this document, select the required cell range to 
create graphs.
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Graph 1

Weekend collection of each child is shown in a column graph. 

Create column graph

Step 1 - Select the cell range by clicking the mouse on B2:D16.

Step 2 -  Click on  in Insert ribbon.
  
Step 3 -  Select a suitable graphs from the list and click on it.

Graphs are always created on the worksheet in which the relevant information 
is available. Therefore, the graphs have to be taken to “Chart Sheets”. Follow 
the steps given below for that;.
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Step 1 -  Click on graph created in the worksheet.

Step 2 -  Click on ''Move Chart Location''  in the 'Design' ribbon 

Step 3 -  In the Move Chart dialogue box, 
  click New Sheet → OK.

Step 4 -  To add a title to the graph. 

   In the ‘Design’ ribbon use 'Quick Layout'.

Step 5 -  Select 'Change colours' to add colours to the graph.

Graph 2

The graph bellow shows the collection of each child as a percentage in a Pie 
chart.  
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Let us create a pie chart

The cell range for pie chart is the cell range of names (B2:B16) and the total 
(E2:E16). These cell ranges are not adjoining. Let us select the cell ranges 
fi rst.

Step 1 -  Select cell range (B2:B16) with the names of the children.

Step 2 -  Pressing the ctrl key on keyboard, select the cell range for 
totals (E2:E16)

Step 3 -  Click on Pie chart tool in the Insert ribbon. 

Step 4 -  Select a suitable graph form the list and click on it.

Step 5 -  Take graph to another graph sheet.

Step 6 -  Do the necessary formatting. Save the document and close it.

Activity 2.10

Create graphs using other information in the table.

Note well : Before crating graphs using information in 
First term marks 2 enter marks for absent students as 
well.
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Activity 3.1

By referring to the flowchart, indicate whether the given statements are 'true' 
or 'false'.

Start

Instruction 1

Instruction 2

Instruction 3

Instruction 4

End

Condition 1

Condition 2

No

Yes

Yes

a) Condition 1 in the flowchart is 
executed first. (True/ False)

b) Instruction 1 does not execute 
under any condition. 

 (True/ False)

c) Condition 1 is executed after 
Instruction 1. (True/ False)

d) Execution of Instruction 3 
depends only on condition 2. 
(True/ False)

e) For Instruction 4 to be executed, both condition 1 and condition 2 must be 
true. (True/ False)

f) Whatever the outcomes of the conditions may be, Instruction 1 and one 
another instruction will be executed. (True/ False)

As mentioned in the Information and Communication Technology, Grade 7 
Reading book, download the scratch software from http://www.scratch.mit.du

l%uf,aL ixj¾Okh3 l%uf,aL ixj¾OkhProgramming3
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Activity 3.2 

Consider that, a school has four houses namely Metta, Karuna, Muditha and 
Upeksha. A flowchart to assign students to their houses is given below. Houses 
are assigned based on the remainder after dividing the admission number by 
4. 

Begin

Remainder = 0?

Remainder = 1? 

Remainder = 2? 

Show ''Karuna''

Show ''Muditha''

Get Admission No

Remainder = Admission No MOD 4

End

Show ''Upeksha''

Show ''Metta''
Yes

Yes

Yes

Yes

No

No

No

No

Any more 
students?

Remainder House
0 Metta
1 Karuna
2 Muditha
3 Upeksha

Here, the remainder is 
obtained by dividing the 
Admission No. by 4. 

e.g. - Admission No. = 342

342
32

4

22
20
2

85

342 MOD 4 = 2

Student is assigned to 
Muditha House.
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Answer the following questions. 
1. A number that cannot exists as a remainder

 1) 0  2) 2  3) 3   4) 4 

2. A suitable remainder for a student assigned to Upeksha House is:

 1) 3  2) 2  3) 1   4) 0 

3. How many conditions are there in this flowchart?

 1) 1  2) 2  3) 3  4) 4

The Scratch program to divide all students in the school into houses is shown 
below. Connect with arrows the instructions relevant for blank spaces.

     

Activity 3.3

Develop a Scratch program to divide the students in your school into houses.  
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Activity 3.4

1. Develop a program with an array to enter 5 subjects learnt in Grade 9.
2. Construct a suitable program based on an array to output seven days of the 

week. Name the Array as “day”.
3. Find answers based on the array called “color” shown below.

4. How many times the above program is repeated when it is executed?    
5. How many colors can be assigned to the array “color”?   
6. Select the suitable statements and match them with the instructions given 

below. 

a)  To delete all the items in the array.  

b)  Number of items in the array  

c) The fi rst item in the array   

d) Entering items into the array.              
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Activity 4.1

Make a list of equipment in everyday use that can collect data from sensors 
and controlled by a microcontroller.
e.g. -

² Device to detect people or animals entering to a farm secretly    
² Device to detect elephants entering to villages

Activity 4.2

Make a list of advantages of using microcontrollers.

Activity 4.3

Connect the micro:bit module to the computer and use the Block Editor to 
code the following items using block.

When a new project is obtained, the following two blocks are displayed.

Get ‘show string’ from 'Basic' and connect it to ‘on start’ and change it to Sri 
Lanka.

Use of Microcontrollers4
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Get ‘pause’ from 'Basic'. Connect it to ‘show string’ and change it to 2000.

Get ‘show number’ from 'Basic'. Connect it to 'pause' and change it to 1.

Get ‘show icon’ from 'Basic'. Connect it to ‘forever’ and change to the symbol 
'√ '
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Download the codes to the computer arranged above, install them in the 
micro:bit module and observe the objects. 
Experiment 2 - Connect to the micro:bit module and use the micro:bit Block

 Editor to do the coding using the blocks. 

Get ‘show string’ into ‘on start’. Change to temperature and compass.

Get ‘on button A pressed’ in the Input menu and include the Bloke ‘show 
number’.  

Get ‘Temperature’ from the Input menu into ‘show number’.

Get ‘on button A pressed’ from the Input menu and change at as B. Get ‘show 
number’ into it. Next, get ‘compass heading’ from the Input menu and include  
it in ‘show number’.
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Get ‘on button A pressed’ from the Input Menu and change it to A+B. Include 
'clear screen' into it by getting from Basic Menu.

The arrangement is as shown below; 
Download the above coding. Install in micro:bit module. Observe the output 
by pressing the buttons A and B separately and both buttons together.

Activity 4.4

Entering data into microcontroller chip in Arduino Board

 The Arduino board must be connected to the computer as shown. Enter 
the programs constructed using the Arduino programming language into the 
microcontroller chip of the Arduino board.
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Arduino Programming Language is an Open Source software and the user is 
allowed to modify the program decoding to his/her requirements.

The cable connecting the Arduino Board to the computer has USB at 
one end and miniUSB at the other. The USB is connected to the computer and  
the miniUSB is connected to the Arduino Board. 

Software used to program the microcontroller chip in the 
Arduino Yuno Board

 The software known as Arduino is used for the purpose. It can be 
downloaded from the website www.arduino.cc when it is installed in the 
computer it can be seen as given below.
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The Arduino Yuno board can be connected to the computer using a USB 
cable and the codes constracted using the Arduino software can be uploaded 
to the microcontroller chip in the Arduino Yuno board. Then the outputs are 
produced through the pins in the board according to the codes.

Activity 4.5

Connect the Arduino Board with the peripherals as shown.

Step 1 - Connect the LED bulb

LED bulb is connected to the GND and the 13th pin.

USB port connecting to 
computer

Step 2 -  Connect the PIR sensor as shown in the image below;

GND

OUT

VCC (+5V)
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In PIR is a sensor,

 ² GND pin connected to the GND port in power section.

 ² OUT pin is connected to the 9th  pin of the Digital Section.

 ² VCC pin is connected to VCC in the power section.

Contract the cording given below in the Arduino software, upload and observe.

void setup(){

pinMode(8,INPUT);

pinMode(13,OUTPUT);
}

void loop(){

Int val=digitalRead(8);

If(val= =1){

digitalWrite(13,HIGH);
  }
else{

digitalWrite(13, LOW);
  }
}
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Activity 4.6

Connect the Arduino Board with the ultrasound wave sensor as shown below;

In this ultrasound wave sensors,

² GND pin in the  Board is connected to the GND port in the power section.

² TRIGGER pin in the Board is connected to the 2nd  pin of the Digital 
section.

² ECHO pin in the Board is connected to the 4th pin of the in Digital section.

² VCC pin in the Board is connected to the 5V port.

² The LED bulb is connected to the GND port and the 13th pin. 

Connect the Board to the computer. Do the coding shown. Upload the code to 
the Board and study the procedure.
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void setup(){

Serial.begin(9600);

pinMode(13,OUTPUT);

pinMode(2,OUTPUT);

pinMode(4,INPUT);

}

void loop(){

long duration, distance;

digitalWrite(2,HIGH);

delayMicroseconds(100);

digitalWrite(2,LOW);

duration=pulseIn(4,HIGH);

distance=(duration/2)/29;

delay(10);

if((distance<=10))

{

digitalWrite(13,HIGH);

}

else if(distance>10)

{

digitalWrite(13,LOW);

}

}
   

Distance = (duration/2 )/29

The distance between the obstacle and the sensor is shown in centimeters.
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Computer Networks5
Activity 5.1

Identifying the main components in the school’s network

1. With the assistance from your teacher, inspect the computers in the 
computer laboratory and identify those that are networked and the devices 
and how they are connected.  

2. Complete the table below with information collected about the computers 
and the devices in the computer laboratory.

Hardware
Available or 

not Numbers Wired or 
Wireless

Function 
(briefl y)Have Haven't

Computers
Server 
computers
Switches
Routers
Printers
Scanners
Multimedia 
projectors
Other
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Activity 5.2

Given below is a block diagram of a computer network showing how the 
computer and the devices are connected.

The table below indicates the details of the connected hardware;

Devices connected Code
A few computers C1, C2, C3…
Switch S
Router R
Printer P
Internet I
Server SVR

'
Identify the hardware to match the code given. Indicate the correct code of the 
hardware in the diagram above.
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Activity 5.3

Select the most suitable word from those in the box to fi ll the blanks in the 
statements 1 - 10 given below.

server, wired, network, networking system, fi ber optics, cables, Internet, 
computer network, communication, resources, social networks, wireless, 
Wi-Fi, instant messaging

1. Inter-connection between and among people or a number of systems is 
identifi ed as a ................................ 

2. Connecting together two or more computers and peripherals is identifi ed 
as a ................................ 

3. The main aim of networking computer is for communication to share 
................................ 

4. A benefi t in computer networking is the facility to use the 
................................ 

5. There are two types of media to connect computers. They are: 
................................ and ................................ connections.

6. Wireless computers use the ................................ technology.  

7. ................................ enables communication among users in a network. 

8. The ................................ enables connect printers, fi les and software for 
sharing purposes.

9. Modern day computers also have built-in facilities for .............................     

10. ................................ are used to connect computers for networking.
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Activity 5.4

Select from B, the most suitable expression to match each expression in A.  
Write the number of the matching expression in the blank alongside B.

A B
1. RJ45 switch ''''''''''''''''

2. Main objective of 
computer networking twisted pair cable ''''''''''''''''

3. Command Line 
Interface

Ability to store 
important information 
in a folder in the 
Internet

''''''''''''''''

4. Allows for direct and 
effi  cient communication 
between the computers 
in the network and other 
peripherals

connecting one 
computer network to 
another network or to 
the Internet 

''''''''''''''''

5. Bluetooth network ''''''''''''''''

6. The computer that 
provide the central 
access to resources

port used to connected 
cables in wired 
networking

''''''''''''''''

7. Is used as a medium in 
computer networking communication ''''''''''''''''

8. Router used to send messages 
in the network ''''''''''''''''

9. Is a benefi t of 
networking computers server ''''''''''''''''

10. An interconnected 
group of people, items 
or a systems 

used for wireless 
connection between 
computer devices

''''''''''''''''
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Activity 5.5

Sharing fi le folder

² Consider an instance of sharing pictures, lessons, photographs, songs, 
video clips and the like among friends.

² To make this activity easy, let us fi rst create folder named “Students Files’’ 
in the C drive of the hard disk.

     (You may select a name of your choice for the fi le).

² Copy into this folder, all pictures, photographs, songs, video clips and 
other fi les for sharing purposes. 

Note well : Login to the computer using an 
Administrator Account. The states of your account 
may not allow you for certain settings. 

Therefore, your teacher will demonstrate this activity. The 
Operating system used for this activity is Windows 10.

² Now, let us set the “Students Files” for sharing in the network.

² Follow the given procedure to change settings in the operating system. 

Step 1 -  Open ‘Control Panel’. Click “Network Sharing Centre”.

1
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Step 2 - Click ‘Change advanced sharing settings’.

2

Step 3 -  Select options from those given to share fi les and printer.

3

4

5

Step 4 -  Select C Drive in your computer. Follow the given procedure to 
select “Students Files” in it.
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7

6

8

Step 5 -  Right click on ‘Students Files’ in C drive and click ‘Properties’.

9

Step 6 -  Click the button ‘Share’ in ‘sharing’.
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10

11

Step 7 -  From the list select ‘everyone’. Click ‘Share’. 

        

12

13
Step 8 -  Click ’Done’ in the dialogue box that appears.

   
14
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² You have completed the process to share fi les in ‘Students Files’.  
Everyone in the network is now able to share all fi les in the fi le folder 
“Students Files’’.

² This process facilitates sharing any fi le in a fi le folder. A user in the 
network can also copy fi les into this folder

Activity 5.6

Sharing printer

² By sharing  a printer allows any user in the network to send fi les from his/
her computer to the printer for printing. However, the printer has to be 
confi gured for the purpose.

² The same fi rst three steps in the above process need to be followed in this 
process which is not mentioned here again.

² A further few steps have to be followed. They are given below:  

Note well : Login has to be with an Administrator 
Account.  You teacher will help you with the process. 

² Set the printer for common use among users in the network.

Step 1 - Go to Control Panel, select ‘Devices and Printers’ and click on it.

1
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Step 2 -   Select the printer connected to the network among the devices  
   shown. In the menu you get, click ‘Printer Properties’.

3

2

Step 3 -     Click ‘Sharing’ in dialogue box you get.

           

4
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Step 4 -     Select ‘Share this printer’ in dialogue box. Press 'OK' button.  

5

6

This completes the process to access the printer in the network. Everyone in 
the network can now share the printer for printing.

 Activity 5.7

Communication through computer networks  

² A user in a computer network can communicate with another user in the 
same network  and any user can also receive a message from any another 
user in the network. In this, sending messages using the Connect Line 
Interface (CLI) is used.

² Consider sending the message ‘Hello, how are you?’ to other users in the 
network, using the CLI in Windows 10.

² Let us send the message, ‘‘Hello! How are you?” to a Friend logged in as 
student 1. Follow the process given below;
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Step 1 -   First, get the Command Line Interface on your computer. Follow 
the procedure given below to get Command Line Interface. Click 
‘Start’ button. On ''Windows Systems'', right click it in the menu 
you get. Click ‘Run’.

1

2

Step 2 -  In the dialogue box received, type “cmd” in front of “Open”. Click 
'OK' button.

3

4

You will receive the Command Line Interface.
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Type ‘msg’ command on Command line Interface. Type user name to collect 
the message. Type the message and press 'Enter'. The message will be sent 
to the user. The steps given below shows the process to send and receive 
messages.
Remember to give correct user name and correct “msg” message. Let us try 
sending a message.

² Assume that the message is, “Hello, how are you?” and the user name of 
the receiver is 'student 1'.

² The system of using the msg command is msg user name message  
Therefore, in the command line, you need to type ‘msg student 1 hello 
how are you?’

² The command, user name and message require spaces in between.

Step 3 -  On the Command Line, type ‘msg student 1 Hello, how are you?’ 
and press 'Enter'.

5
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Your message appears on Student 1’s computer screen as follows:

Activity 5.8

Sending a message to all users in the network system

Let us learn how to send the message, ‘Hello, how are you?’ to all users in the 
network system. 

² The same msg command is used in this case.
² In the previous activity you used the user name of receiver student 1 after 

msg command.
² However in here, instead of  one user, * mark for 'all' is used.
² Therefore, the command you need to type is msg * Hello, how are you? 
² Type correctly on the Command Interface and press Enter.
² All users of the network will receive the message. Use this command to 

send diff erent messages.

Note: The activities were all with Windows 10 system. If you are 
using Windows 7 or those before it, type ‘net send’ command 
instead of ‘msg’ command.
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Activity 6.1

² Work in groups.
Ã Make lists to show the use of computers and Information 

Communication Technologies and their services in your school. Share 
the information you obtained with other groups.

Ã Given below are a few machines use to diagnose illnesses. Find the  
instances they are used and label accordingly.  

           Machine                                                            Use 

Blood pressure testing machine

ECG - Electrocardiogram machine

CAT

Internal examination of brain using 
Electro Magnetic Rays EEG

Blood sugar teasing machine

ICT and Society6
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Look around. Find other equipment using Information Communication 
Technologies. Make lists. Compare lists with others.

Activity 6.2

What steps can be taken to minimize the digital divide in the society?

Activity 6.3 

Complete the table below about places in the country that collect e-waste.  
Collect information from books by talking to elders, or by collecting 
information using the Internet services.

Organization Address Telephone No.
1
2
3
4
5

Activity 6.4

List out e-waste that can be reused.
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Activity 6.5

Write True/ False in front of each statement. 

1 All e-waste cannot be reused.
2 E-waste pollutes our environment.

3 We are not responsible for the damage caused to the 
environment from e-waste.

4 To keep surroundings clean, e-waste can be taken dumped 
in garbage collecting centers.

5 E-waste can be used to create ornaments. 

Activity 6.6

Read newspapers to fi nd available opportunities for Information 
Communication Technology related careers. Complete the following Table 
using the collected information.

Career Organizations 
providing career

Required 
qualifi cations

Role

1
2
3
4
5
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Activity 6.7

Find suitable expressions from “Computer related careers” lesson in the 
textbook to complete the blanks in the text below. 

An entrepreneur, anxious to use information communication technology 
for business purposes consulted ............................... to gather information 
on the subject. ................................ created software required for 
the business process. Quality regarding  the developed software was 
assured by the ................................ The ................................ designed 
attractive advertisements. The businessman also wished to take the 
business online. For this ................................ assisted him. Since it 
was required to manage all the places in the building from the offi  ce 
................................ networked the business premises. 
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